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Using TimePro
The first section of this manual deals with the day-to-day use of TimePro. If you want to know
about setting up and configuring TimePro, see the section of this manual entitled ‘Configuration of
TimePro ‘ on page 27.

What is TimePro?
The TimePro system consists of an electronic clock terminal and software that processes and
analyses employees’ clockings made at the terminal. Employees use the terminal to clock in and
out of work and can also clock on and off jobs. When used for clocking on and off jobs, the
TimePro system also records what type of work has been done. This is achieved by entering a two
digit ‘Sale Code’ when the employee clocks onto a job. If an employee who clocks on jobs does not
have a job, the system will record this non-productive time by using ‘special’ job numbers. The
TimePro system will also record if an employee does not clock onto a job or a non-productive
activity.
The clocking data is stored in the terminal until it is downloaded into the computer that is running
the TimePro software. The data can then be checked for incorrect clockings and various reports
produced. These reports include attendance, payroll information, holidays, absence, job efficiency,
profitability and lost or non-productive time.
There are two basic versions of TimePro that relate to the way that sold or allowed hours for jobs is
entered:
The Standard version allows this information to be entered after employees have worked on the
jobs and the clockings are processed in TimePro. This version allows two methods of inputting sold
hours, either on a job-by-job basis or employee per day basis. (See ‘Inputting Sold / Allowed Hours
(Standard Version)’ on page 11)
The Pre Time version allows the user to input the allowed time for a job. TimePro then
automatically processes the actual clockings against this target time. This version is suitable for
low throughput businesses such as Motor Body Shops.
Using TimePro divides into these areas
1.
2.
3.
4.
5.

Communicating with the clocks(s)
Booking Holidays and Absence
Checking / editing the Time and Attendance Data
Checking / editing the Job Costing Data
Printing the required reports

Communicating with the clocks(s)
Click the clock button on the top toolbar to open the clock screen.
This screen defaults to ‘Normal Collection’ and ‘All Hard wired Clocks’ (See ‘Clock Operations’ on
page 21 for details of other clock operations)
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Click the ‘Run Clock Operation’ on the lower toolbar, you will be asked to confirm the operation,
Click Yes, TimePro will then start downloading the data from the time clock(s), wait until this
operation has finished and the progress bar has closed. If TimePro does not communicate with
the clocks(s) you will receive a time-out message after about 10 to 15 seconds. This is probably
because of the clock was in use at the time you tried to do the download, in which case just repeat
the operation.
If you have clocks on remote sites that are connected by modem, select the appropriate clock from
the dropdown box at the top of the clock screen and repeat the download operation.
After each download, TimePro will process the clockings. The status of the process is shown to
you via a progress bar.
When all clocks have been downloaded, close the clock screen by clicking the ‘Stop’ button on the
left of the lower toolbar.

Booking Holidays and Absence
Holidays and absence can be booked into the programme at any time.
Click the ‘Holiday / Absence’ button on the top toolbar.
This screen has three ‘tabs’

Book
This is where you book any absences; use the dropdown boxes to filter the companies,
groups and employees you wish to book absence for. To book individual employees,
uncheck the ‘All employees’ box and click the check box next to the employee(s) that you
are dealing with.
Choose the type of absence form the ‘Type of Absence’ dropdown box. The ‘Paid’ and
‘Rate’ values will default to the values that you have set up for this absence. You can
override these if you wish. If the ‘Paid’ box is checked the employee will be paid at the rate
shown in the ‘Rate’ field.
In the Hours section you have the following options:
• Use Day Rules, this will use the number of hours allocated in the Day Rule.
•

Use Overtime Rules, this will use the number of hours allocated in the Day Rule but will
use the overtime rules for payment. For example, if the Day Rules absence hours are
eight with the first seven hours paid at rate 2 and the remaining hours paid at rate 2 and
you check the ‘Use Overtime Rules’, seven hours will be paid at rate 1 and one hour at
rate 2. You can use this facility to pay two different rates of pay for absence even if the
employee normally is paid overtime on a weekly basis.

•

Specify, use this option to pay a specified time in hours and minutes. The first time will
be paid at the rate shown in the ‘Rate’ box at the top of the screen, the second time will
be paid at the rate specified in the ‘Rate’ box to the right of the second time field.

Check the ‘Reduce Holidays’ box if you want the absence to be deducted from the
employees’ holiday entitlement. Check the ‘Half Day’ box to reduce the holidays by half a
day.
Check the 'Do NOT include in Overtime calculations' box if you do not want the paid
absence to count towards any overtime, for example, an employee must work 40 hours
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before he moves to an overtime rate. If you wish the paid absence to be included in the 40
hours, leave the box UNCHECKED, however, if you wish the employee to work 40 hours in
addition to the paid absence then CHECK this box. (The same principle applies to
employees on Daily Overtime)
Choose the date range that you are booking the absence for by using the ‘From’ and ‘To’
date boxes (clicking the arrow at the side of the box will show a dropdown calendar)
Finally, if the date range includes weekends and you wish to book those days check the
‘Include Weekends’ box.
To confirm the absences, click the ‘Book’ button on the lower toolbar.
If try to book more than one absence for the same employee on the same day, you will be
given a warning with an option to book the additional absence or cancel. If more than one
absence is booked, the ‘Multi Absence’ field will be set to ‘Y’ (see Edit Tab)

Edit
Once absences have been booked, they can be viewed and edited here.
The default view is all absences after the current date, to see earlier dates, click on the
dropdown calendar and choose the required date. Alternatively, check the ‘Show All
Absences’ box to see all records.
The records can be sorted in date or employee order by clicking on the date or employee
column header, clicking the header again will sort in descending order.
You can change the time paid, the rate of pay, and whether holiday entitlement is reduced
or not. Just type in the new values, to change the reason for the absence click on the row
you wish to change in the ‘Reason’ column. A dropdown box will appear from which you
can choose a new reason.
To delete a booked absence, click in the row you wish to delete and click the ‘Delete’
button on the lower toolbar. To delete multiple records, hold the Control (Ctrl) key down and
click on each record on the box at the left hand end of the row, each row will be highlighted
as you select it. Click the ‘Delete’ button.
The ‘Multi Absence’ column indicates if you have booked more than one type of absence
for an employee on the same day. (The last absence booked will be shown in the reason
column)

Absence Codes
To ‘Add’ a new type of absence, click the ‘New’ absence button on the lower toolbar and
type in a description. If you wish to pay an employee for this absence, change the paid
column to a ‘Y’, in the rate column, enter the rate at which it will be paid.
To ‘Delete’ an absence, click on the row you wish to delete and click the ‘Delete’ button on
the lower toolbar. TimePro will not allow you to delete an absence if it is already in use.
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Making Ad-hoc Payments
You can use the Holidays and Absence screen to make ad-hoc payments that are not
catered for by normal clocking etc. For example, you wish to pay employees an extra
payment equivalent to one hours work at rate 2 if they work at night.
•
•
•

Create a new absence code called ‘Night Shift Premium’
Set the rate as 2
When an employee works at night, simply book an ‘absence’ of Night Shift Premium
and use the specify option, enter 1 hour as the time to pay.

Checking / Editing the Time and Attendance Data
As the data is downloaded into TimePro, the clockings are processed against employees shift
patterns etc. if every employee clocks in and out correctly, no further action will be required.
However, in the real world, people forget to clock in or out (or even both!) so it is necessary to
check that no errors exist.
Click the ‘Time and Attendance’ button on the top toolbar.
The Time and Attendance’ screen is empty when first shown, click the ‘Refresh’ button on the
lower toolbar to bring the latest data onto the screen. If you wish to see data for previous weeks,
click the ‘Week Ending’ dropdown box at the top of the screen and choose the desired week.
At the top of the screen are dropdown boxes that will allow you to filter the employees by company
and groups. You can also see records for only current employees (the default) or all employees
including those that are on hold (see ‘Employee Tab’ on page 17)

Screen Layout
The top half of the screen shows the attendance clockings for the first employee.
There are four ‘Tabs’ that give different views:
1. Edit
This is the only view where the clockings can be edited, deleted of added. Also on this
screen is a column entitled ‘Status’, this shows if any errors such as uneven clockings have
been found.
2. Rounded
This shows how the actual clockings have been rounded in accordance with the Day Rules.
3. Actual
These are the actual clockings as entered at the clock.
4. Combined
This view shows both the edited and rounded values for each clocking.
The lower half of the screen shows the calculated hours to be paid at the various rates of overtime
for each day. Also shown is the gross pay for each day as well as total hours and gross pay. There
are two further columns on the lower grid:
1. Brought Forward (B/Fwd)

Copyright MIM Systems Ltd 2000 - 2004

Page 7

TimePro from MIM Systems
If weekly overtime is in use, any time that is carried over for work done after the week
‘ends’ time will be shown here.
2. Cash Adjust (£/Adj)
If you wish to make a one off cash payment to an employee you can enter the amount here.
To note the reason for the cash adjustment, click the appropriate button (for the day you
are dealing with) to the right of the lower grid. This will display an input box.

Editing Data
To edit a clocking, ensure that the ‘Edit’ tab is clicked, click on the clocking you wish to edit and
type in the new value. Press enter to save the new value. If you press the escape key whilst editing
the clocking, the original value will be restored.
To add a new clocking, click on an empty cell anywhere in the row and type in the new clocking
value. Press enter to save the clocking. Do not worry if the clockings are not in order, TimePro will
sort them when it calculates.
To delete a clocking, click on the cell you wish to delete and use the backspace key or spacebar to
erase the clocking,
You can add and delete clockings from any point in the rows, you do not have to shuffle clockings
to put them in the correct order; TimePro will do this for you when it calculates.
NOTE: Midnight Clockings. Midnight (00:00) is the first minute of the day. If an employee has
forgotten to clock off on a shift that ends at midnight, the clocking should be inserted on the day
after that shift was started.

Overriding the Overtime Calculations
In most cases, the hours to be paid at rate 1,2 etc can be determined by the Day Rule / Shift setup.
If you have a situation that can not be catered for in this way, you can override the amounts to be
paid by amending them in the lower grid. The total amount of hours to be paid must equal the time
worked. After amending the rates, click the appropriate ‘lock’ box on the RH side. TimePro will not
let you lock a record is not correct.
If you amend a clocking or book an absence after locking a record, it will be unlocked when
recalculated.
When you have finished editing, click the ‘Calculate’ button on the lower toolbar.

Other Toolbar Buttons
Use the First, Previous, Next and Last buttons on the lower toolbar to move from employee to
employee.
Use the Previous Week and Next Week buttons to move from week to week. (Holding the Shift
key down as you move from week to week will stay with the same employee)
The ‘Refresh’ Button shows the latest values, including changes made by other users on a
network system.
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The ‘Calculate’ button will calculate the data to reflect any changes that are required if you have
edited any data. You can see if this is required by looking at the status bar of the main screen,
which will show the words ‘Calculate Required’. There is also a ‘Calculate’ button on the top toolbar
that carries out the same function. TimePro will automatically calculate if it is required when you
move to another week or close the Time and Attendance screen.
Clicking the ‘Next Discrepancy’ button will take you to the first record that TimePro can find with
an error. Click this button again to move to the next discrepancy and so on.
The ‘Add New Records’ is used to create blank daily records. Normally TimePro creates a record
for each employee for the appropriate dates as data is received form the clocks. Should a clock be
out of action it is possible to create new records so that you can enter clockings manually. Select
the date range required form the dialog box and click ‘OK’
‘Recalculate’ as TimePro processes the clockings; the current values for rates of pay, Day Rules,
job sale and cost values etc are applied. If you change any of these values and wish to apply them
retrospectively, you will need to recalculate. Select the employees affected and the date ranges
required and click ‘OK’
‘Book Absence’ if you are in the Edit Tab, click on the row in the Status column for the record you
are working with. Click the ‘Book Absence’ button, the Holiday and Leave screen will be shown
with employee and date you are working with. Choose the required absence and click ‘Book’.
When you return to the Time and Attendance screen it will refresh to show the booked absence.
NOTE: Right clicking the mouse can access many of the above toolbar functions.

Checking / Editing the Job Costing Data
Before editing any of the job costing data you should ensure that you have checked and corrected
the Time and Attendance clockings first as job clockings will not be processed until the relevant
Time and Attendance data is correct.
Click the ‘Job Clockings’ button on the top toolbar.

Screen Layout
At the top left of the screen are dropdown boxes that allow you to filter jobs to companies and
employees. In most cases you would leave these set to ‘All’.
The next two dropdown boxes allows you to filter the job clockings that you will work with. The
default is a single Job Number, with the job status as ‘All’. Other options are ‘All Jobs’ and ‘By
Date’ when you choose the later, the date field boxes are enabled and you can select the ‘From’
and ‘To’ dates. (NOTE: the records are not filtered until the ‘To’ date is set).
Using the ‘Productive Status’ dropdown you can filter jobs further. This gives the following options:
1. All
Shows all Job Clockings.
2. Productive
Shows only Job clockings that are for actual Jobs.
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3. Non-Productive
Shows Job clockings on Non-Productive jobs, these have the special numbers from 2000 to
2050.
4. Missed
Shows Job clockings that have been created by TimePro because the employee did not
clock onto a job within the specified period from his start time. These clockings have the
special number of 1997. (See ‘Default Job’ in the ‘Employees’ Section on page 18) Any
‘Missed’ clockings should be changed to an appropriate Job or Non-Productive number.
Below this section is a record grid. Each row of the grid shows a Job Clocking. The full detail of the
clocking is shown in the lower half of the screen, therefore as you move from row to row, the boxes
in the lower half will show the detail for the current record.

Editing Data
To see clockings for a single job, select ‘Job Number’ from the ‘Job’ dropdown and select ‘All’ from
the ‘Productive Status’ dropdown. Type the Job Number in the Job Number box and press the
enter key.
The grid will show all clockings for that Job Number. You can edit any of the values that are blue in
the edit boxes, which are:
1. Job Number
This can be changed to a valid Job Number or a Non-Productive number. Clicking the
button next to the Job Number box will give you a list of non-productive codes.
If you change from a Non-Productive code to a Job Number, the sale code will be changed
to 5 and the sold / allowed time set to zero. If you change from a Non-Productive code to a
Job Number you will be prompted to change the sale code and the time allowed will be
changed to time taken.
2. Clock On Time
It is only possible to adjust the ON time of a job, this is because TimePro will automatically
adjust the OFF time for you. If you alter the ON time of a job the previous job OFF time will
be adjusted accordingly (when TimePro calculates).
3. Sold or allowed time (Only applies where Sold Time is entered on a per job basis)
You can change the sold time for an individual clocking but TimePro will do this for you
automatically when you enter ‘Sold Hours’. (See the paragraph entitled ‘Inputting Sold /
Allowed Hours’ later in this section)
4. Sale Code
This can be set to a valid Sale Code, click the
button to get a list of available codes.
You cannot set a non-productive clocking to anything other than 5.

Inserting a Job Clocking
If an employee forgets to clock onto a job or non-productive activity, this can be done via the
TimePro software. Click the ‘Insert Clocking’ button on the lower toolbar. Fill in the appropriate
fields. You only need to know the start time; TimePro will work out the finish time and adjust the
other clockings accordingly.
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Deleting a Job Clocking
It is not possible to delete a job clocking. The clocking should be corrected to the appropriate job
number or sale type. Alternatively, you can set the clock ON time to the same as the OFF time.

Inputting Sold / Allowed Hours (Standard Version)
This section applies to the Standard version of TimePro; if you are using the Pre Time version
please see ‘Job Manager (Pre Time Version)’ on page 14.
There are two options for inputting sold hours into TimePro. The option you use will have been
determined at the time of installation and it is not practicable to switch from one type to the other,
however if you do wish to change, please contact MIM Systems Ltd for advice.
You can easily determine which option you are using by the location of this toolbar button:
If it is on the top toolbar of the main screen, you are inputting sold hours on a Per Employee Per
Day Basis. If it is on the lower toolbar of the Job Clockings screen, you are inputting sold hours on
a Per Job Basis.
Per Employee Per Day Basis
To use this option you will need to collate the total hours sold by each employee on each
working day. To input the hours, click the
button on the top toolbar. This will open up
the Hours Input screen. Productive employees are listed in date order. By default, the last
30 days are shown. If you want to see all dates, click the ‘All Dates’ option.
Enter the sold time against each employee. Click the ‘Close’ key when finished.
Per Job Basis
To use this option you will need to collate the hours sold per job by employee and sale
type. Choose ‘Job Number’ form the ‘Job’ dropdown box. Choose ‘All’ from the ‘Productive
Status’ dropdown box.
Enter the job number you are dealing with in the ‘Job Number’ box and press the enter key.
All the clockings for the job will be shown in the grid.
Click the
button on the lower toolbar of the Job Clockings screen. This will show the
‘Update Sold Hours’ screen. (From build 3.0.203, holding the Shift key down & pressing the
enter key will also show the Sold Hours screen)
(See next Page)
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The employees, who have worked on the job, are listed by the type of work done. As you
click on each employee, the total time taken by that employee is shown. Enter the time sold
by that employee and press enter. This will jump to the next employee. When all employees
have been done, press enter or click the ‘Update’ button. TimePro will look through all the
employees’ clockings, by sale type, and make any adjustment on the final clocking. If you
have the ‘Prompt to Close’ option set (see next section ‘Closing Jobs’) then you will be
asked if you wish to close the job at this stage.

Automatically allocating sold time to all employees
If more than one employee has worked on a job and you just wish to enter the total sold time for
the job, TimePro can allocate the time proportionate to the time each employee has taken on the
job. Open the Sold Hours Input screen as shown above, enter the total sold time against the first
employee, hold the SHIFT key down and then press ‘Enter’ or click ‘Update'

Closing Jobs
A job should be ‘closed’ in TimePro when all work has been completed on the job. TimePro uses
the open/closed status to determine the Work in Progress figures. As mentioned in the section
above, ‘Per Job Basis’, you can close a job after updating sold hours. You can also Close / Reopen
a job at any time by clicking the
button on the toolbar.
To Close/Reopen several jobs at once, click the
, you can select multiple jobs by holding the
shift or control keys down and clicking on the job numbers you wish to close. To sort the jobs by
date order, click the ‘Order by Date’ option. To see closed jobs, click the ‘Show Open Jobs’ check
box (This option is not available on the Pre Time version of TimePro.)

Auto Close Jobs
If you are inputting sold hours on the Employee per Day basis, you can set TimePro to
automatically close jobs over a certain age. This is done during a clock download. If you use this
method you should realise that the Work in Progress figure is not accurate, the facility is provided
for those users who are not worried about an accurate figure and wish to reduce the amount of
daily work involved with TimePro. To switch on Auto Close, see Job Costing setup on page 34
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Inputting of sold hours after a job has been closed.
Normally, a job would only be closed once it has been invoiced. However, some users prefer to
‘close’ a job after updating sold hours on all jobs whether they have been invoiced or are still in
use. You may wish to do this, for example where a job spans a several days but you wish to
update the sold hours on a day-by-day basis.
TimePro does not have a problem with this, any new clock records will be open and only these
open clockings can be edited.
To make the updating of sold hours simpler you can choose to select whether the total time is
shown in the updating sold hours dialog box, or only the time that is applicable to open clockings.
To set this option, select the ‘Options’ tab in the Job Costing setup screen. (Accessed by this
button on the top toolbar:
.) Check the box ‘Update only OPEN Clockings with sold hours’. (See
page 34)
The following example will illustrate this.
Show all hours.
Joe Bloggs works on a job 123456 on Monday for two hours. The following day the sold time is
entered as two and half-hours and the job is “closed” in TimePro. On Wednesday Joe works a
further hour on job 123456. When the new clocking is viewed in TimePro the input hours dialog will
show three and a half-hours (two-and-a-half hours previously entered as time sold on the Monday
clockings plus the one-hour spent on Wednesday).
Show only open hours.
Using the previous example, if you have elected to show only open clockings, when the
Wednesday clocking is viewed in TimePro the input hours dialog will show one hour being the time
spent on the job 123456 on Wednesday. The times sold from the previous clockings, which have
now been closed, are not included.

Other Toolbar Buttons (Job Costing)
Use the First, Previous, Next and Last buttons on the lower toolbar to move from Job to Job.
The ‘Refresh’ Button shows the latest values, including changes made by other users on a
network system.
The ‘Calculate’ button will calculate the data to reflect any changes that are required if you have
edited any data. You can see if this is required by looking at the status bar of the main screen,
which will show the words ‘Calculate Required’. There is also a ‘Calculate’ button on the top toolbar
that carries out the same function. TimePro will automatically calculate if it is required when you
close the Job Costing screen.
Clicking the ‘Find Next Un Matched Sale Code’ button will take you to the first record that
TimePro can find with an unknown sale code. Correct the error and click this button again to move
to the next discrepancy and so on. If no errors are found TimePro will give a message to that
effect. (This option does not apply to the Pre Time version of TimePro.)
The ‘Multiple Job Number Change’ button allows you to change all records with a particular job
number to another number (or non-productive code) and sale code. This may be required if you
had issued a temporary job number for the employees to clock onto and now wanted to change the
clockings to the correct number. Enter the job number you want to change from and the number to
change to. If you wish to change the Sale Codes, uncheck the ‘Use existing Sale Codes’ and enter
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the sale code you wish to use. Click ‘Change’, you will be advised how many records will be
affected and given the option to cancel. The changes will be recorded in the Job Audit.
The Lock Clockings Button(applies only to the Pre Time Version of TimePro)
Until a job is closed, time allowed will be the same as time clocked. On occasions you may wish to
allocate time ‘sold’ when the job is only part completed. Follow the procedure outlined in ‘Inputting
Sold / Allowed Hours’. The clockings that exist at that time will now be set with the time allowed
that you have just inputted. On the next clock download or calculate they would be overwritten. To
prevent this happening you can ‘Lock’ the clockings. TimePro will then perform calculations on the
new, unlocked, clockings only.
The ‘Reset Job Close Date’ , from build 3.0.269, the date on which a job is closed is recorded.
This is to allow the production of bespoke reports for some customers so will not be relevant to the
majority of users. Use this button if you wish to change the ‘Close’ date
NOTE: Right clicking the mouse can access many of the above toolbar functions.

Job Manager (Pre Time Version)
The Job Manager is only applicable to the Pre Time version of TimePro.
button on the top toolbar. The Job Manager
The Job Manager is accessed by clicking the
allows you to tell TimePro what times are allowed for a job in advance of work be carried out on
that job. When the clockings are collected from the clocks, TimePro calculates the time allowed for
each job using the information from the Job Manager. If any errors are found, they are reported to
you via the Exception screen / report.
The minimum data that is required for each job is: the job number, the operations that are to be
carried out and the time allowed. The other fields such as customer, reference and comment are
provided for your use.

Inserting a New Job
To Insert a new job, click the
button on the lower toolbar, enter a job number and click ‘OK’.
TimePro will set up the job with one operation that is shown in the grid on the right of the Job
Manager screen with operation code and the time allowed for that operation. To change the time
allowed, click in the ‘Time’ column of the grid and type in the new time (in decimal, not hours and
minutes). To change the operation, click in the grid column ‘Desc’, an arrow will appear at the right
which will give a dropdown list of the available operations.

Adding Operations
To Add Operations, click the
button on the lower toolbar. This will add a new operation to the
grid. Change the operation type and time as described above. The total time for the job is shown
above the grid.

Deleting an operation
Click the row in the grid that you wish to delete. Click the
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Changing a Job Number
To job number field is locked to prevent accidental over typing of the number. To unlock the field,
click the button to the right of the field. After you have change the job number, save the changes by
clicking the ‘Save’ button on the lower toolbar. To lock the field, click the lock button again.

Exception Clockings
Every time new clockings are downloaded from the clock or TimePro calculates as a result of any
changes the user has made, TimePro looks for clockings that do not match the data in the Job
Manager. To view the Exception clockings, click the
button on the top toolbar. This will show
the Exception Clockings Screen.
There are three reasons why a clocking may appear here:
1. ‘Not in Job Manager’. Go to the Job Manager and insert the job or amend the Job Number
directly in the exceptions screen if it is incorrect
2. ‘Incorrect Sale Code’ The job exists in the Job Manager but the clocking has used a
different sale code. In this case you need to decide if the Job Manager is correct or the
clocking. If the Job Manager is wrong, (hint, right click the mouse and click Job Manager
Information to get a list of the Sale codes and times in the Job Manager) go to the Job
Manager and amend / create the operations as required. (You can quickly open up the Job
Manager with the job you are working with by holding the shift key down and double
clicking the relevant row in the exceptions screen). If the clocking is incorrect, double click
the clocking in the Exception clocking screen, this will open up the Job Costing screen with
the job you are working with. Make the appropriate changes.
3. The job has been closed. Go to the Job Manager and open the job.
You need to ensure that all Exception clockings are eliminated or the job data in TimePro will not
be accurate, remember to click the ‘Calculate button’ on the top toolbar after making any changes.
If you want a printed report of the Exceptions Clockings, use the Reports Screen
To make multiple job number changes, click the button on the lower toolbar.

Other Toolbar Buttons (Job Manager)
Use the First, Previous, Next and Last buttons on the lower toolbar to move from Job to Job.
The ‘Refresh’ Button shows the latest values, including changes made by other users on a
network system.
The ‘Calculate’ button will calculate the data to reflect any changes that are required if you have
edited any data. You can see if this is required by looking at the status bar of the main screen,
which will show the words ‘Calculate Required’. There is also a ‘Calculate’ button on the top toolbar
that carries out the same function. TimePro will automatically calculate if it is required when you
close the Job Manager screen.
The Search button can be used to search on Job Number, Customer or reference field. Click in the
field you wish to search on and click the search button. Choose the required record from the list on
type in the data you are searching for.
The List button gives a list of jobs in the Job Manager with the customer and reference details.
The Close button is used to close or reopen a job. (See ‘Closing Jobs’ under Job Costing).
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Viewing / Printing Reports
Reports are accessed by clicking the

button on the top toolbar.

A number or reports are available in TimePro. These are listed in the dropdown box entitled
‘Available Reports’ and broadly fall into the following categories:
1. Today’s Clockings
This report shows the clockings for the current day. It is only as up to date as the last clock
download. It shows each employees clockings, both attendance and job. No processing in
terms of rounding or error checking will have been carried out. This reports is useful if the
label printer fails and you need the current days clockings.
2. Clockings / Attendance / Payroll
There are several reports giving clock readings, payroll and absence information.
3. Performance Summary
This is one of TimePro key reports. It only includes productive employees and summarises
the attendance and job performance as well as showing labour sales and cost by sale type.
4. Job Costing / Performance Reports
There are several reports that give information on job based work and non-productive
activities. There are also Gross Profit and Work in Progress reports.
5. Shift, Day & Overtime
This report lists all the settings for the Time and Attendance setup.
6. Bespoke Reports
Any reports that have been created by MIM Systems for an individual customer will appear
at the end of the Available Reports list.

Filtering the data for reports
There are a number of criteria that can be used to filter the data used in the reports. These are
shown on the reports screen and are divided into two categories, General Options and Job Costing
Options. If criteria are not applicable to a particular report, it will be disabled and ‘greyed out’ to
prevent you using it.
On the General Options tab you set options for Companies, Groups, Date Range and Employees.
For companies and date options, select the desired criteria from the dropdown boxes. If you
choose custom dates, you can then set the ‘From’ and’ To’ date using the dropdown calendars.
For the groups, the default is All groups, to select individual groups, uncheck ‘All Groups’ and tick
the box(s) next to the desired groups.
To select individual employees, click the Select button and choose the desired employees from the
list (a maximum of 20 employees can be selected).
On the Job Costing Options you can set options for Job Status, Sale Types and Job Number(s).
Job Status can be set to ‘All’, ‘Open’ only or ‘Closed’ only.
Sale Types default to ‘All’ or you can select individual types (see groups above).
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Job Numbers default to ‘All’. To show just one job number, type the number on the Job Number
box. To use a range of job numbers type the lowest and highest in the ‘From’ and ‘To’ boxes.
The ‘Select’ box will give you a list of all job numbers for you to choose from.
Remember that non-productive codes can be used wherever you use Job Numbers.

Toolbar Buttons (Reports)
The three buttons are:
1. Close, close the Reports Screen
2. Print, This prints direct to the printer, we suggest you preview the reports first as some
reports can be several pages long.
3. Preview, Shows the report on screen, you can then print the report be clicking the printer
button at the top of the preview screen.

Employees
Click the
button on the top toolbar to view the Employee screen.
The screen has two tabs:

Employee Tab
The employee tab has the following fields:
1. Number
This is a unique number given to the employee when he is set up in TimePro, it cannot be
changed.
2. Status
An employee can be either ‘Current’ or on ‘Hold’. Hold should be used where an employee
has left and may return, maternity leave for example, or the employee has left and you wish
to retain the data for him. TimePro will not generate any new records for an employee that
is on hold. If you delete an employee, you will loose all data for that employee.
3. Full Name
This is the full name of the employee. It must include one space so avoid using just first
name or last names.
4. Clock Name
This is the name that will be used at the clock terminal(s) when the employee clocks in and
out. The maximum length is 18 characters and must include one space. If you change the
full name, TimePro will automatically create the clock name and if the full name is greater
than 18 characters, will abbreviate it. You can change the abbreviated name if you wish.
5. Clocks
If you only have hard-wired clocks, leave this at ‘All Clocks’. If you have modem clocks as
well, you can choose whether the employees name will be sent to all clocks, hard-wired
clocks only or a specific modem clock. (See ‘Send Names’ on page 21)
6. Shifts Group
This is the Shift Group that the employee belongs to. (See page 32)
7. Overtime Rule
The overtime rule that the employee works under. (See page 28)
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8. Group
The employee group that the employee belongs to. (See page 27)
9. Default Job
If an employee does not clock onto a job within the time set for AutoClock (see page 34),
TimePro will ‘Clock’ an employee onto his default job. You can choose any of the nonproductive activities so a supervisor can be clocked on to Supervising or an apprentice onto
Apprentice. For a normal productive employee we suggest you use ‘Missed Clocking’. This
will tell you that an employee forgot to clock on a job and give you the choice of what to
clock him onto. (See ‘Screen Layout’ under ‘Checking / editing the Job Costing Data’ on
page 9)
If the employee does not clock on and off jobs, set this to ‘Non Productive’.
10. Non Productive Factor
If an employee clocks on and off jobs but is considered to be only part productive, because
he is a supervisor or an apprentice for example, TimePro will factor his time worked on jobs
to account for this. (This applies only to the ‘Performance Summary’ Report). Enter the Non
Productive factor.

Confidential Tab
The confidential tab has the following fields:
1. Basic Pay
This is the basic hourly rate for the employee. If this rate is not entered, the job costing and
payroll reports will not be accurate.
2. Holiday Entitlement
At the beginning of the holiday year, enter the entitlement for the employee; TimePro will
reduce the figure as you book holidays.
3. Payroll Number
This can be used for a payroll code; it defaults to the employee number.
4. Start and Finish Dates
Set the start date to the employee start date. The finish date should be set to the same as
the start date until the employee leaves when it should be set to his actual leave date.
5. Notes
This is a free field for any information you may wish to record about the employee.

Adding a New Employee
To add a new employee, click the
button on the lower toolbar. Enter a unique number for the
employee. You are recommended to use numbers between 100 and 995, however, TimePro will let
you use a lower number but will warn against it.
Enter the full name for the employee, when you move to the Clock Name field, TimePro will
automatically enter this for you. Select the appropriate options for the employee for Shift Group,
Group, Overtime Rule and Default Job. Complete the appropriate details on the ‘Confidential’ tab.
Punch out an Attendance and, if required, a Job badge.

Copyright MIM Systems Ltd 2000 - 2004

Page 18

TimePro from MIM Systems
You can print badge label(s) for the badges. (See ‘Other Toolbar buttons’ on page 19)
button on the lower toolbar to send the employees name to the clock(s) Note: if you
Click the
have modem clocks, this will have to be done from the Clock actions screen and send all employee
names.

Deleting an Employee
An employee should only be deleted if you are happy to loose all the data for that employee. If you
wish to retain the data it is recommended that the employees status be set to ‘Hold’ (See ‘Status’
on page 17)
To delete an employee, click the
button on the lower toolbar. (It is advisable to delete the
button on the lower toolbar, you will have to
employees name from the clock(s) by clicking the
set the employee status to ‘Hold’ first) Note: if you have modem clocks, this will have to be done
from the Clock actions screen and send all employee names.

Other Toolbar Buttons (Employees)
Use the First, Previous, Next and Last buttons on the lower toolbar to move from Employee to
Employee.
The Print Badge Labels button will show a screen that allows you to print badge labels. Choose
‘Attendance’ of ‘Job Badge’ under ‘Type’. If you want just a particular employee, uncheck the ‘All’
box and check the employee(s) required.
You should use Avery ™ J8651 labels or equivalent which have 65 labels in five columns and
thirteen rows on each sheet. (You can obtain these labels from MIM Systems in single sheets). If
you are using a part used sheet of labels, set the column and row that you want to start printing at.
You can preview the labels on screen or print direct to the printer by clicking the appropriate button
on the lower toolbar of the labels screen.
The Search or find button allows you to search for an employee by name. Double click on the
desired name in the list or start typing in the name of the employee. TimePro will move to the
employee you are searching for.
The Input Basic Pay and Holidays screen allows you to input pay and holiday entitlement for all
employees via a single screen.

Checking Network Status
This is only available if the option 'Calculate Current Days Job Clockings' has been selected in the
Job Costing Setup screen and is only applicable when inputting Hours on a Per Job Basis
With this option, it is only possible for one user to be logged into TimePro and have access to all
functions. Once the first user has logged in, any subsequent users will only have access to reports.
Clicking the 'Network Status' button on the top toolbar will list any computers logged into TimePro.
If you were originally logged in with reports access only and the other computers have now logged
off, you will then be given full access.
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If TimePro reports an incorrect number of users logged in, then log all computers out of TimePro
and start again.

Advanced Operations
System Setup
The System Setup screen is accessed form the ‘File’ menu.
The following settings can be made:
1. Database Location
This is the location of the TimePro databases. On a single computer system this will
normally be C:\TimePro NG\Database. If TimePro is being used on a network, this will be
the path to the computer of server that has the TimePro database files. The database files
are called TPro2000.mdb and TimePro.mdb.
Use the ‘Browse’ button to set the location.
2. Backup File Location
TimePro creates a backup file on shutdown; you can select a different location (for example
on a server) for this file
Use the ‘Browse’ button to set the location
3. Portable Files Location
This is the location for files used with the Portable units. (Please see separate instructions
on the Portable units)
4. Clock Files
When data is downloaded from the clock(s), it is saved in a file (see ‘Clock Files’ on page
21). These files are saved in the location set here.
Use the ‘Browse’ button to set the location.
5. Archive Files
This is the location for Archive files. (See ‘Archiving Data’ on page 24)
Use the ‘Browse’ button to set the location.
6. Days to Archive
TimePro will use this setting when you create an Archive file. (see ‘Archiving Data’ on page
24) This is the age, in days, over which you will archive data. For example, if it is set to 120,
all data that is OVER 120 days old will be saved in the Archive file. All data that is UNDER
120 days old will be left in TimePro.
7. Use This Computer for Backup and Compact
At least one of the computers running TimePro must have this option checked. If possible, it
should be the computer that the databases are located on.
With this option checked and TimePro is shut down, provided no other computers have
TimePro running, the database files will backed up to two files called TPro200.bak and
TimePro.bak in the same location as the database files. (See ‘Restoring a Backup’ on page
24 for details on restoring the backup files)
8. Warn if Backup File cannot be created on shutdown
This option should be selected if TimePro is used on a network and the databases are also
located on a TimePro PC. If this option is selected and a backup cannot be created
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because another user is logged into TimePro a warning will be given not to shut down the
computer.
9. This computer is connected to the Clock(s)
Check this box if the computer is connected to the clocks.

Clock Operations
As well as the normal collection of data from the clocks, a number of other actions can be
performed. These are accessed from the dropdown box at the top left of the Clock Actions screen.

Clock Files
When data is downloaded from the clock(s), it is saved in a file with .dat extension. The files are
located in the folder set under ‘System Setup’ (See page 20). The name of the file will be the date
the collection was made together with a number indicating the order that the file was created. The
first will on any date will be 0 the second 1 etc. For example, ‘Dec 22 2000 0.dat’. A letter ‘M’
before the sequence number indicates it is a modem collection and the letter ‘E’ indicate that it is
an emergency collection.
These files can be viewed / edited from the clock screen (see ‘Other Toolbar Buttons (Clock
Screen)’ on page 22)
The clock screen displays all data that is being sent and received to / from the clocks.

Normal Collection.
See ‘Communicating with the clocks(s)’ on page 4

Emergency Collection
Every time you download data from a clock, a copy of that data is kept in a second memory
in the clock. Should a problem occur with the download and data is lost for some reason,
you can use the Emergency Collection to get a copy of the data.

Set Clock Time
The time / date of the clock(s) can be set. The time and date used will be that of the
computer so ensure it is accurate before carrying out this operation.
TimePro will wait until a full minute is reached before setting the time.

Send Names
The names of all employees are stored in the clock(s). You should use this operation when
a new employee is added in TimePro. It is recommended that a normal data collection be
carried out before this action is done.
After the clock has been programmed with the names, the clock will be set to reject any
unknown employee badge or number. (See ‘Toggle List Exclusive’ below)
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Test Collection
This will carry out a normal clock download but will not clear the clock memory or process
the data.

Memory Clear
THIS WILL CLEAR THE MEMORY IN THE CLOCK(S). Use this action with care, it is
designed for deleting the memory after repair work or testing the clock and should not be
used under normal circumstances. TimePro will automatically clear the memory after a
successful normal download.

Toggle Exclusive List
When the clocks are programmed with the employee names, the clocks are set to
‘Exclusive’. This prevents an unknown badge or number being used. Using ‘Toggle
Exclusive List’ you can switch this option on and off. Use once to switch on; use again to
switch off etc.

Check Serial Number
Each clock has a unique serial number. If this number is required you can use this action to
retrieve the number without physically inspecting the clocks.

Other Toolbar Buttons (Clock Actions)
The Clock / Modem Setup button will show the Clock Setup screen, the following settings can be
made:
1.
2.
3.
4.

Number of Hard Wired Clocks
COM Port of the Hard Wired Clocks
COM Port used for the modem (if used)
Timeout time in seconds
This is the time that TimePro will wait if there is a break in data transfer; it is normally set to
15 seconds. This time is automatically increased by 10 seconds when a modem is being
used.

5. Baud rates for the hard and modem COM ports. This is normally 1200.
6. Do not clear clock memory
This option is normally used for testing purposes only. If checked, the clock memories will
not be cleared after a download. Use this option when advised by Technical Support.
System Configuration
Your system will either be hard wired direct to a PC or will be via your local area network. If it is a
network system, the Network tab allows the IP address of the clock(s) to be set.
Click the Modem Tab to show details of any modem clocks that are used. To add a new modem
clock, click the ‘New’ button on the lower toolbar and type in a description for the clock such as
‘Workshop’. The new clock will be shown in the grid. Enter the phone number for the clock in the
right hand column.
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Other options for modem set up are:
1. Outside Line
Check this option if the phone line is accessed via a switchboard, you will also need to set
the number that needs to dialled for the line.
2. No Dial Tone
This should be checked if the phone line does not produce a dial tone.
3. Modem Initialisation String
TimePro uses this information to configure a modem prior to dialling a remote clock. Any
changes to this setting should be made with care. The last 2 characters should always be
X4. If you wish to return to the original settings, click the ‘Restore’ button.
The Open Data File button will show the open file dialog box. Use this option if you wish to load
clocking data direct from a file. This would only normally be done where the data file has been
edited or copied form another computer.
View Collected Clocking Files. The clock files can be viewed and edited via this screen. The
screen lists the clock files in descending date order but in ascending collection order. The right
hand column gives a description of the type of file. (See ‘Clock Files’ on page 21)
The files can be viewed and edited by clicking the ‘View / Edit’ button on the lower toolbar.
The files can be reloaded into TimePro by clicking the ‘Reload Clock File’ button. Reloading the file
will not cause any harm as any duplicates will be ignored, however, any clockings that you may
have deleted in TimePro will be reloaded.
Every download creates a separate clock file if you have more than one file and wish to reload all
the files for one day, start with the file ending in zero (for example Dec 22 2003 0.dat) which is the
first file for the day, after saying 'Yes' to the prompt 'Confirm you wish to reload these clockings'
you will then get a further prompt asking if you wish to load all that days clockings
You may see a file called ClockError.txt. TimePro creates this file if it detects an error with the data
as it is downloaded from the clock(s). This can happen if electrical interference occurs or, if using a
modem, there is interference on the phone line.
TimePro will advise you of this at the end of the download process and give you the opportunity to
view the error. If you view the file it will look something like this:
21/11/00 18:07:39
Correct Format
##345678 dd DDMMYY HHMM
Actual
00000054 TU 21110 1613
-----------------------The first line shows the date and time that the error occurred.
The line under ‘Correct Format’ shows what TimePro was expecting to find, in this case this is an
attendance clocking. The first 8 characters are the employee number, the next 2 are letters
denoting the weekday followed by 6 characters for the date (ddmmyy) and finally the last 4
characters are the time.
The last line will show what TimePro actually got. In this case, you can see that the last ‘0’ is
missing from the year. You can edit the file to correct the error and then save it. Make sure that the
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actual line is the same as the correct line in all respects including spaces in and at the end of the
line. You should then reload the file using the procedure described on page 22 (View Collected
Files)
A job clocking is similar to the attendance clocking but has extra characters for the job number and
sale type.

Archiving Data
Creating an Archive
As time passes, the data held by TimePro will increase. This will slow down the calculation times,
as more and more data has to be processed. Old data can be archived to a file. In this way, the
data is not lost and can be viewed when required. (See ‘Opening an Archive File’)
When you create an archive file, all data that is over the age set in System Setup (see page 20) is
saved to the archive file. From the ‘File’ menu, choose ‘Create Archive’. This will show a save file
dialog box, enter a name for the file such as ‘Data up to 1-3-00’ and click ‘Save’. This operation
can only be completed if the only user is the one creating the archive file. If TimePro is in use by
other users on a network you will get a message to tell you that the operation could not be
completed.

Opening an Archive File
To open an archive file, choose ‘Open Archive File’ form the ‘File’ Menu. To return to the current
data, choose ‘Return to Current Data’ form the ‘File’ menu.
If TimePro detects that the archive database needs upgrading, it will do this automatically when
you open the archive file.

Backup
Creating Backups
There are two forms of backup that should be considered with TimePro:
1. TimePro Backup
When TimePro shuts down, backup files are automatically created’ where possible the
backup file should be located on another computer or server (see ‘System Setup’ on page
20). This operation is only run from the computer designated for that purpose and only if no
other users are running TimePro.
2. User Backup
If the TimePro backup is on the same computer as the main database, should the hard
drive fail, both the original and backup could be lost. It is strongly recommended therefore,
that users keep a backup of the data to an external device such as a Zip or Tape drive. Use
the backup software for the device to backup the files TPro2000.mdb and TimePro.mdb.
These files are located in the database folder as set in ‘System Setup’ 9 (see page 20)

Restoring a Backup
To restore the TimePro backup, choose ‘Restore Backup’ from the ‘File’ menu. (See also
‘Database Repair’ on page 26) If TimePro cannot be started, see Database Repair on page 26
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To restore a User Backup, follow the instructions of the Zip or Tape software.

Security
By default, security is switched off. To activate security protection, choose “Password” from the
setup menu. This will show the change password screen. You will notice that the user is ‘master’
and that the ‘Old password’ box is greyed out. To activate security, a password must be assigned
to user ‘master’ this is done by entering a password in the ‘Password’ box and re-entering the
same password in the box below. NOTE: passwords are CASE sensitive.
A senior person such as the department manager should carry out the setting of the
password for user ‘master’. The password should be carefully recorded, as it will only be
used to log on to TimePro to assign or delete other users, set permissions or to disable
security.

Setting up users
Once a password has been assigned to user ‘master’, close TimePro and restart. You will now see
a log in dialog box. Enter ‘master’ (lowercase and without the quotes) in the User Name box and
the password you created earlier.
From the ‘File’ menu, choose “User Admin”. (This operation is only available if you log on as user
‘master’). From here you can create new users and delete existing users.

To create a user
1.
2.
3.
4.

Enter the password for ‘master’
Enter a name for the new user
Enter a password for the new user
Re enter the password

(Note: User names and passwords can be any combination of letters or numbers but must be at
least four characters and no more than ten characters. User names and Passwords are CASE
sensitive)
Click the ‘Add’ button. A message will advise that the user has been added to the user list. To
maintain security, the new user should log on to TimePro and change his password to a password
known only to that user.
A list of users is available by clicking the browse button next to the User Name box.

To Delete a user
1.
2.
3.
4.

Log on as User ‘master’ and go to User Admin.
Enter the password for ‘master’
Enter the User Name or select it from the list
Click the ‘Delete’ button.

Changing a Password
If you need to change a password, log on as the User you wish to change the password for, select
‘Password’ from the ‘File’ menu. Enter the old and new passwords as required.

Forgotten Password
If a user has forgotten their password, log on as ‘master’, delete the user and recreate as a new
user.
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Disable Security
Log on as User ‘master’, select ‘Password’ from the ‘File’ Menu.
Enter the old password for ‘master’. DO NOT enter anything in the new password boxes. Click ‘Set’

User Permissions
Once a user has been created, you can set permissions for that user. In this way you can restrict
what a user can do and see in TimePro.
You must be logged on as ‘master’ to set permissions.
Choose ‘User Permissions’ from the ‘File’ menu.
At the top of the Permissions screen is a dropdown box with a list of all users. Choose the user you
wish to set permissions for.
By default, a user has permission to do everything in TimePro. Uncheck the items that you do not
wish the user to have access to. When you have set permissions for all users, close the
permissions screen.
The user permissions will take effect the next time a user logs on.

Database Repair
Occasionally, the TimePro databases may become corrupted. A computer being shut down when
TimePro is still running usually causes this. Always ensure that all programmes are shut down
before a computer is powered down.
If a database is corrupted you will probably be unable to start TimePro and will get an error
message. Go to the windows start button, go to Programs and then to the TimePro NG folder. Click
the ‘Repair Utility’ icon and follow the instructions.
If a database cannot be repaired, you will need to restore the backup file. This must be done by
running the Repair Utility on the computer that is used for TimePro backup.
Run the Repair Utility, click the button ‘Restore Backup’ you will be advised of the date and time of
the available backup. If you restore the backup, the original database file will be backed up.
After you have restored a backup, you will have to reload any clock downloads carried out since
the backup (see Viewing Clock Files on page 22) you will have lost any data such as Sold Hours,
New Employees etc that had been created since the backup.

Updates to the TimePro software
Software updates will be issued to you when required. This will be by CD Rom or floppy disc.
Any update must be run on ALL COMPUTERS THAT HAVE TIMEPRO INSTALLED.
1. ENSURE TimePro IS NOT RUNNING ON ANY COMPUTER
2. Insert the CD or floppy disc as applicable
3. Go to the TimePro NG folder on the Program Menu. Click the ‘Update Utility’ icon
This will start the TimePro Update Programme
4. Choose the update source (CD or Floppy disc) from the dropdown box. If you are using a
CD or Floppy on another computer on a network, check the ‘Use Network PC / Server’ box
and use the ‘Browse’ button to locate the network source.
5. Click Update
6. Wait until the progress bar has completed and a message box advises that the update is
complete
7. Repeat the above an all computers running TimePro
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8. If the update fails for any reason, contact MIM Systems for advice

Configuration of TimePro
Before dealing with the details of the shift setup, please consider the following and how it applies to
your company. Please take some time to study these carefully. They will help you to understand
the way TimePro works.

Companies / Groups / Rates of Pay
To access Companies and Groups setup, click the

button on the top toolbar.

Normally, there will only be one company but you can have multiple companies each with their own
groups of employees. However, all companies must use the same pay multipliers (see Rates of
Pay)
Each company can be divided into groups for reporting purposes. These may be logical groups
such as Office Staff and Productive Staff or could be teams of people within the same department.
An employee can only belong to one group.
Up to five rates of pay are available, rate one is basic i.e. a multiplier of one. Typically you would
have Time and one third, Time and one half and Double time but you can use any multiplier for the
other four rates.
The screen has two tabs:
Companies / Groups Tab
The left hand grid shows the companies (there must be at least one) together with the ID of the
company. In the right grid is list of groups and the company ID of the company each group belongs
to.

To add a new Company or Group
Click the ‘New’ button on the lower toolbar. Choose company or Group as applicable and type a
name for the new Company / Group.
If you have created a new group, click on the Company ID column in the group grid and assign the
group to the correct company.

To delete a Company or Group
Click on the Company or Group that you wish to delete and click the ‘Delete’ button on the lower
toolbar. TimePro will not allow you to delete a Company or Group that is in use.
Defaults Tab
On this tab you can set the rates of pay and their multipliers. Rate 1 should always have a
multiplier of 1; the other rates can be anything you choose. These rates are used in the Day and
Overtime Rules.
The Last Day of Week should be set before you use TimePro for the first time. This is the ‘Last’
day of your pay week.

Day Rules, Shifts, Overtime and Shift Groups
The setup screen for the above is accessed by clicking the
The setup screen has the following tabs:
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Default settings. You will notice that there is a ‘Default’ for all of the above. TimePro uses these
when setting up a new employee. You can modify them if you wish but it is recommended that you
create your own rules etc.

Overtime
Two types of overtime rules are available in TimePro:
Daily Overtime
An employee is paid overtime on a day-by-day basis, for example, the working day is eight hours
and the employee works ten hours. He is paid two hours overtime regardless of the total hours
worked for the week.
If you only use Daily overtime then you do not need to create any overtime rules as this is dealt
with under the Day rules. (See ‘Day Rules’ on page 28)
Weekly Overtime
If an employee has to reach a weekly target before he is paid overtime, for example, on a forty
hour week overtime only starts to be paid after forty hours has been worked irrespective of the
hours worked on a day by day basis.
It is possible to specify exception days (up to three) for example Saturdays and Sundays, when an
employee will be paid at overtime rates even though the target has not been met.
You can have as many weekly rules as you wish, for example, a weekly rule with a target of twenty
hours for part time staff and a weekly rule with a target of forty hours for full time staff.
Note:
An employee can only have one type of overtime but you can have different employees on different
rules, for example, office staff may be on a weekly rule whilst productive staff could be on a daily
rule.
To Create an Overtime Rule, click the ‘New’ button on the lower toolbar and enter a meaningful
description such as ‘Weekly 40’
Enter the hours (in decimal) to pay at each rate. For example, 40 hours at rate 1, 20 hours at rate 2
etc.
If you wish to apply Daily Overtime on specific days. Choose the days from the dropdown boxes. If
you want the weekly target to be reached first, check the ‘Hit Target First’ box. If you use this
option, make sure that the Day Rules for these days are set up with the hours and pay rates that
you wish to pay.
If you want to enforce Time Banding (see ‘Day Rules’ on page 28) from the Daily Rules, check the
‘Force Time Band Rules’ box.
The ‘Week Ends’ Time denotes the time, on the last payday of the week that the week ends. Any
work after that time will be carried forward to the next pay week.

Day Rules
A Day Rule is required for each type of ‘Day’ an employee could work.
The number of Day Rules you require will depend on the complexity of you working patterns. There
follows two examples that will help to illustrate this:
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Example One, Simple 40 Hour week.
Employees work Monday to Friday with the same start and finish times. On a Saturday, they work
only the morning.
In this example only two ‘Day Rules’ would be required:
Day Rule One:
Day Rule Two:

Mon to Fri
Saturday

Example Two, Early and Late Shift each day, shorter day on Friday.
Employees can work Monday to Thursday on either an early or late shift. On Friday, the working
day in one hour less. On a Saturday, they work only the morning.
This would require the following Day Rules:
Day Rule One:
Day Rule Two:
Day Rule Three:
Day Rule Four:
Day Rule Five:

Mon to Thur, Early shift
Mon to Thur, Late shift
Friday, Early shift
Friday, Late shift
Saturday

To Create a Day Rule, click the ‘New’ button on the lower toolbar and enter a meaningful
description, for example, ‘Productive Early’
The basic elements of a day rule are:
1. Start Time: The start time for the day e.g. 08.00.
2. Finish Time: The finish time for the day e.g. 17.00.
3. Overtime Start before shift: When do you want to pay overtime to someone who clocks in
before shift start? For example, on a shift start of 08.00, setting this to 07.30 will only pay
overtime if an employee clocks in before 07.30, if he clocks in after 07.30 he will be paid
from 08.00.
If this field is left blank then the employee will not be paid until the start time regardless of
when he clocks in.
If it is set to the same time as the start time then the employee will be paid overtime from
when he clocks in (subject to grace and rounding rules)
4. Overtime Start after shift: How much time do you want to allow after the shift finish time
before overtime kicks in? This allows for cleaning up etc and is typically 15 minutes.
5. Minimum Time to Work before overtime Starts: Enter the minimum time in hours and
minutes, that an employee must work before getting overtime. TimePro will compare the
total time worked against this setting and the value set in the Hours to Pay at Rate 1 (or
Rate 2 if Rate 1 is blank, Rate 3 if Rate 2 is blank and so on). If the total time worked is
greater than the Rate time but less that the Minimum Time to Work, then the total time is
reduced to the Rate Time. Leave this setting blank if you wish the employee to move onto
overtime as soon as the Rate time is exceeded. This setting is not applicable to Day Rules
that go over midnight.
If using this setting on a Day Rule that applies to an employee on a Weekly Overtime
Rules, you would normally set Rate 1 to 23:59 but for this facility to work you must setup
Rates 1, 2 etc as for a normal Day Rule
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If you use this option with an productive employee you need to be aware on the effect it has
when producing the Performance Summary Reports. On these reports, you will see a
column 'Unpaid Hours'. This is the time deducted from the attendance time by enforcing
this option. The value of the Unpaid Hours is also deducted from the Productive Time (Time
clocked on Jobs) for the employee. This is to ensure the Utilisation, Productivity and
Efficiency calculations are meaningful.
6. Paid absence hours: If an employee is absent and is to be paid (e.g. Holiday) the number
of hours to pay. (TimePro uses the first day rule that an employee could have worked for a
given day, see ‘Shift Groups’ on page 32)
7. Grace Times: How many minutes grace on clock IN and OUT (they can be different for IN
clockings and OUT clockings but all IN’s will be the same as will all OUT’s)
8. Rounding Times: If the grace period is exceeded, what rounding to apply? For example 15
minutes. (Again, they can be different for IN clockings and OUT clockings but all IN’s will be
the same as will all OUT’s)
9. Flag if Early Finish, Late Start or Absent: the TimePro reports can show if an employee
has started late, finished early or was absent on the day. Click the check boxes as
applicable.
10. Hours to Pay at Rate 1,2,3,4 and 5: This is applicable to Daily Overtime Rules AND
exception days for Weekly overtime. Enter the hours to pay at each rate, for example, the
first eight hours at rate one, the next two at rate two, the rest at rate three etc. if this is a
Weekly Overtime day it will be 23.59 hours at rate one. (Unless you are using the Minimum
Time to Work option)
11. Time Banding: You can specify a different rate of pay if an employee works between
certain times, for example, if he works between 05.00 and 08.00 in the morning, pay at rate
two irrespective of overtime rules.
12. Cash Adjustment If a shift allowance or other payment is to be made if this shift is worked,
enter the amount and reason.
13. Deduct Break: If you do not want an employee to clock OUT and IN for an unpaid break,
enter the minutes to deduct. Note: This time will always be deducted irrespective of whether
it was actually worked on not. Productive employees (employees who clock on and off jobs)
must always clock breaks to ensure accurate job times, so you should NOT use this option
on a day rule that is to be used by productive employees. (See also AutoClock Break)
14. AutoClock Break Normally, productive employees should clock OUT and IN for lunch
breaks, however, if this is not possible you can set an OUT and an IN time for the break in
the day rules. Clockings will be automatically entered the first time a day is calculated. If
you subsequently delete the clockings, they will not be reapplied during calculation. Be
aware that the job clockings shown in the TimePro reports WILL NOT marry up with the
labels produced by the clock terminal as the label will include the time taken for the break.
15. Allow Flexi Breaks: By default, the Rounding settings are applied to all attendance
clockings. This can cause problems if you wish to use roundings of, say, 15 minutes but
wish to allow employees to clock lunch breaks on a flexible basis, for example 12:10 to
12:40. If 15 minute roundings are used here, the employee’s clockings will be rounded to
12:00 and 12:45. By selecting 'Allow Flexi Breaks' all attendance clockings EXCEPT the
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first and last clocking of the shift will be rounded to 5 minutes. If you use this option, the
Grace on IN and Grace on OUT should be less than 4 minutes

Shifts
A ‘Shift’ consists of a set of Day Rules, Monday to Sunday. In the examples given earlier:
Example One (Simple)
Only one shift is required:
Shift One

Day

Day Rule

Mon
Tue
Wed
Thu
Fri
Sat
Sun

One
One
One
One
One
Two
Default1

Example Two (Complex)
Two Shifts would be required:
Shift Early

Shift Late

Day

Day Rule

Mon
Tue
Wed
Thu
Fri
Sat
Sun

One
One
One
One
Three
Five
Default1

Day

Day Rule

Mon
Tue
Wed
Thu
Fri
Sat
Sun

Two
Two
Two
Two
Four
Five
Default1

To Create a new Shift click the ‘New’ button on the lower toolbar and enter a meaningful
description such as ‘Early Weekday’
In the grid at the right of the screen you will see a list of weekdays. Against each day, click on the
dropdown box and choose the Day Rule that you wish to use for that day.
Repeat the above for all the Shifts that you require.

1

A Default Rule is provided for days that are not normally worked
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If a shift goes over midnight, check the ‘Shift goes over Midnight’ box. You will also need to enter
the overflow time. This is the time, in hours and minutes that TimePro will look after the shift end
time for the last OUT clocking. If an OUT clocking is not found in that time you will get an ‘Uneven
Clockings’ message in the Status column on the Time and Attendance screen.
To Delete a Shift, click the ‘Delete’ button on the lower toolbar. TimePro will not allow you to delete
a Shift that is in use.

Shift Groups
The last element is the ‘Shift Groups’. This is where TimePro can work out which shift and day rule
to place an employee in based on the first IN clocking of the day, using the examples given before:
Example One (Simple)
The Shift Group would be:
Clock IN Time Until:
Use Shift:

23.59
One

Example Two (Complex)
The Shift Group would be:
Clock IN Time Until:
Use Shift:

11.00
Early

Clock IN Time Until:
Use Shift:

23.59
Late

In this example we can see that an employee who clocks in at 08.00 on Monday will be placed in
the Early shift and will use Day Rule One. If on Tuesday, he clocks in at 14.00 he will be placed on
the Late shift and will use Day Rule Two.
To Create a Shift Group click the ‘New’ button on the lower toolbar and enter a meaningful
description such as ‘Early and Late’.
Use the ‘Add Shift’ button to add as many shifts as required (the new shift will be ‘Default’, click on
the dropdown box and select the desired shift.)
The shifts should be in the order that an employee could use them, for example Early, Late, and
Night etc. if a night shift is involved it should always be the last shift.
Against each shift, enter the ‘Until’ time. TimePro will look at the first IN clocking and decide which
shift the employee is using based on the ‘Until’ time. (see the example above)
To Delete a Shift Group, click the ‘Delete’ button on the lower toolbar. TimePro will not allow you to
delete a Shift Group that is in use.
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Shift Organiser
The combination of Day Rules, Shifts and Shift Groups can become quite complex. To see the
combination in a graphical layout, click the
button on the top toolbar.
This screen is for information only and shows how the Shift Groups, Shifts and Day Rules fit
together. Click the + signs to expand the views and the – sign to collapse the views.

Job Costing Setup
The Job Costing Setup is accessed by clicking the

button on the top toolbar.

The screen has three tabs:

Sale Codes
These are the codes that the employees use when they clock onto a job. Number 5 is always NonProductive and should have a value of £00.00.
To Add a new code, click the ‘New’ button on the lower toolbar. Enter the number (between 10 and
60), a description and a value for the code. The value should be the average rate per hour that this
work is sold for.
The descriptions and values can be edited directly in the grid at any time.
If you create a new code, it can be used at the clock(s) straight away. However, the clock will
report the code as ‘Not Used’ on the display and the labels. You will require the clock EPROM
reprogramming to show the new code(s). Please contact MIM Systems who will carry out this work
at a minimal charge.
To Delete a code, click in the grid on the code you wish to delete and click the ‘Delete’ button on
the lower toolbar. TimePro will not allow you to delete a code that is in use.

Non-Productive Codes
These are the codes that are used on the downtime cards. An employee at the clock uses these
cards when he does not have a job to clock onto. There are two types of Non-Productive work:
1. Allowed
These are activities where an employee could not physically work on a productive job. For
example, driving, on-site training etc. you should use the number range 2000 to 2040 for
these codes.
2. Disallowed
These are activities where an employee would be available to work on a productive job. For
example, waiting or idle time. You should use the number range 2041 to 2050 for these
codes.
Whether a code is allowed or disallowed is used in the ‘Performance Report’. On all other reports
Non-Productive time is shown as zero time sold.
To Add a new Non-Productive code, click the ‘New’ button on the lower toolbar. Choose Allowed
or Disallowed and enter a description. TimePro will allocate a code for the new activity that you
should use to punch out a new card.
Badge Labels can be printed by clicking the ‘Badge’ button on the lower toolbar.

Copyright MIM Systems Ltd 2000 - 2004

Page 33

TimePro from MIM Systems
To Delete a code, click in the grid on the code you wish to delete and click the ‘Delete’ button on
the lower toolbar. TimePro will not allow you to delete a code that is in use.

Options
The following options can be set for Job Costing:
1. Sold / Allowed Hours Input (Applies only to the Standard Version of TimePro)
Choose hours per job (recommended) or hours per employee per day. (See ‘Inputting Sold
/ Allowed Hours (Standard Version)’ on page 11)
2. Update only OPEN clockings with sold hours
See ‘Inputting of sold hours after a job has been closed.’ On page 13
3. Prompt to Close after Updating Sold / Allowed Hours
Check this box if you want to be prompted to close a job after sold hours has been updated.
4. Days to look back for last job.
If you set an employees ‘Default Job’ to ‘Last known clocking’ this is the days that TimePro
will look back. If no job is found TimePro will clock the employee onto ‘Missed Clocking’.
(See ‘Default Job’ under ‘Employee Tab’ on page 17)
5. Minutes before AutoClock invoked
(See ‘Default Job’ under ‘Employee Tab’ on page 17)
6. Job Number size
Choose either six or eight depending on the configuration of the TimePro clocks. (NOTE
this setting will not alter the ability of the TimePro clocks to accept either 6 or 8 digits.
Please contact MIM Systems for an EPROM upgrade if you require 7 or 8 digit job
numbers)
7. Auto Close
8. This option is only available when inputting sold hours on an Employee per Day basis. If
checked, any jobs older than the number in the ‘Days to keep WIP’ will be closed when you
do a clock download
9. Calculate Current Days Clockings. (This is only available when inputting time on a per job
basis) Normally, the current day’s job clockings are not processed unless the attendance
clockings are correct. if you wish to be able to see the current days job clockings so that
you can input sold hours, select this option. There are certain restrictions that this option
places on the use of TimePro:
1. Only one user can be logged into TimePro at any time and have full access to all
functions. Subsequent users logging into TimePro will be advised what computers are
logged into TimePro will be advised that they can only access reports
2. The actual calculation of the Job clockings is dependant on the accuracy of the
employees clockings, if errors are made with attendance clockings, the on/off times for
the jobs may appear inaccurate
3. The job clocking for the job / activity that the employee is on at the time of the download
will have the same on and off times
4. No processing of the default job will be carried out
When all attendance clockings are correct, calculation will be carried out as normal
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Setting the TimePro Clock Terminal for British Summertime
The TimePro terminal can be programmed to change in March and October for the start and end of
British summertime. When the TimePro system is installed, the clocks are programmed for the next
two changes.
You will need the ‘Mode 2’ card that was supplied with the TimePro system.
1) Before making any adjustment to the clock, you need to ensure it is set to BST (British
summertime) or GMT (Greenwich Mean Time) as appropriate.
A) If the current date is after the October time change and before the March time change the
clock display should show the letter ‘G’ in the top right hand corner of the display.
B) If the current date is after the March time change and before the October time change the
clock display should show the letter ‘B’ in the top right hand corner of the display.
C) If the display is showing a ‘G’ when it should be a ‘B’ or vise versa then the clock is out of
step with the changes and should be changed as follows, (if it is showing the correct setting
then go to 2)
(a) Insert and remove the Mode 2 card, the display will now read ‘Mode 2 Selected’
(b) Press the ‘Enter’ Key THREE times, the display will now read ‘Mode 5 Selected’
(c) Press button 9 ONCE, the display will read ‘Change now’ and either ‘Spring
Change ‘ or ‘Autumn Change’ you can scroll between the two by pressing
buttons 5 & 6 respectively. Choose whether you want to change to BST (Spring
Change) or GMT (Autumn Change) and press ‘Enter’
(d) When you have made the change, press ‘Clear’ twice to return to the normal
display.
(e) IF YOU HAVE HAD TO MAKE A CHANGE AS ABOVE then you will need to
set the clock time using TimePro software (See Setting Clock Time on
Page 21)
2) To set the next two Dates for the time changes, carry out the following:
A) Insert and remove the ‘Mode 2’ card the display will now read ‘Mode 2 Selected’
B) Press ‘Enter 3 times, the display will now read ‘Mode 5 Selected’
C) Press button 8 once
D) The display will read ‘Change on date Spring Change’
E) Press enter once, the display will read ‘Spring Change Date- nn – Mar.
F) Use buttons 5 & 6 to scroll the date to the required setting (Usually the last Sunday in
March)
G) Press Enter to confirm the date
H) Press button 6, The display will read ‘Change on date Autumn Change’
I) Repeat steps E to G (Usually the last Sunday in October)
J) When all changes have been made, press ‘Clear’ twice to return to the normal display.
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